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4. Instalacja  

4.1 Wymagania systemowe 

Aby zainstalować Voltsoft, komputer powinien posiadać:  

- procesor Pentium 233-megahertz (MHz) lub szybszy 

- conamniej 1GB of RAM 

- conajmniej 2GB dostępnej pamięci na twardym dysku  

- USB 2.0 / 3.0 Port(s) 

Voltsoft pracuje tylko z następującymi systemami operacyjnymi:  

- Microsoft Windows XP Service Pack 2 lub wyższy 

- Microsoft Windows Vista Service Pack 2 lub wyższy 

- Microsoft Windows 7 

Jeśi twój system Windows nie zawiera odpowiedniego Service packa najpierw wykonaj aktualizację 

Widowi.  

Biblioteka .NET wersja: - .NET framework 2.0 SP2 

Jeśli twój system Windows nie posiada odpowiedniej biblioteki.NET framework, dzięki programowi 

Voltsoft będziesz ją mógł wgrać z Internetu. Przed instalacją zaleca się najpierw dokonanie 

aktualizacji.  

4.2 Instalacja Voltsoft 

1. Umieść płytę instalacyjną CD-ROM w komputerze.  

2. Menu otworzy się automatycznie, (jeśli instalacja nie rozpocznie się automatycznie, dwukrotnie 

kliknij na autorun.exe w katalogu CD-ROM). 

Krok 1: Wybierz język instalacji 
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Krok 2:Kliknij Next, aby wykonać kolejne kroki.  
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Krok 3:Rozpoczęcie instalacji 

 

Krok 4: Instalacja drivera urządzenia USBXpress  

 

Krok 5: Instalacja drivera połączenia USB z UART  

 

Krok 6: Kliknij Finish, aby zakończyć instalację.  
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4.3 Rejestracja Voltsoft 

Voltsoft posiada dwie wersje: standardową i profesjonalną. Wersja profesjonalna zawiera więcej 

funkcji niż wersja standardowa.  

Standardowa vs. Profesjonalna  

Standardowa   Profesjonalna 

Zarządzanie użytkownikiem        G 

Zarządzanie pocztą         G 

Ustawienia ogólne        G  G 

Preferencje językowe        G  G 

Wzór emaila          G 

Zarządzanie urządeniem (dodaj/usuń)      G  G 

Wykres użytkownika        G 

Email alarmowy         G 

Interfejs sieciowy        G 

 

Voltsoft zostanie domyślnie zainstalowany w wersji standardowej. Aby uruchomić funkcje wersji 

profesjonalnej użytkownik musi zakupić pakiet oprogramowania (VoltSoft Data Logger, BN: 101333) i 

wprowadzić ważny klucz licencyjny (dołączony na płycie CD) w celu rejestracji.  

Aby dokonać rejestracji:  

1. Uruchom klienta Voltsoft Windows  

 

2. Kliknij Help->Online Activation 
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3. Wpisz ważny klucz licencyjny i informacje o rejestracji.  

4. Wpisz ustawienia serwera Proxy, jeśli komputer łączy się z Internetem za pomocą serwera Proxy.  

5. Kliknij przycisk “Activate”, aby dokonać aktywacji on-line.  

6. Po zakończonej aktywacji, wyświetli się następujący komunikat.  

 



                                 

Strona 9 z 64 
Dystrybucja Conrad Electronic Sp. z o.o., ul. Królowej Jadwigi 146, 30-212 Kraków, Polska 

Copyright © Conrad Electronic 2012, Kopiowanie, rozpowszechnianie, zmiany bez zgody zabronione. 

www.conrad.pl 

www.conrad.pl 

5. Wersja standardowa  

5.1 Uruchom klienta Windows Voltsoft  

Aby uruchomić aplikację, przejdź do Start Menu->All Programs->Voltcraft->Voltsoft Client 

Ekran główny klienta Voltsoft wygląda następująco:  

 

1 Obszar Main Menu – W menu głównym użytkownik ma dostęp do różnych funkcji.  

2 Obszar Device List – zawiera spis urządzeń już zarejestrowanych w systemie.  

Zielona ikona – oznacza, że urządzenie jest podłączone do komputera.  

Czerwona ikona – oznacza, że urządzenei nie jest aktualnie dostępne.  

Klikając na ikonę możemy otworzyć urządzenie w obszarze panelu sterowania dla tego urządzenia.  

3 Device Control Panel – w tym obszarze wyświetli się otwarte urządzenie.  
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5.2 Ustawienia ogólne 

Aby uruchomić ten moduł, kliknij na File->Settings. 

 

1 Unit Preference - Wybierz jednostkę pomiarową używaną w Voltsoft. 

2 Data Storage – Aby zapobiec przepełnieniu danych, system usunie automatycznie stare dane. 

Użytkownik może określić liczbę dni na zachowanie odczytu urządzenia.  

3 Download Data – Jeśli zaznaczono tę opcję, system wgrywa nowe dane z czasem pomiarowym, 

które już istnieją w bazie danych, wówczas istniejące dane zostaną nadpisane.  

4 Email Settings – Ten obszar konfiguruje ustawienia poczty wychodzącej.  
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Email Sender – wysyła e-maile alarmowe.  

SMTP Server and Port – nazwa i numer portu serwera poczty wychodzącej.  

Login ID and Password – Login i hasło serwera SMTP (jeśli wymagane).  

Enable SSL – Zaznacz tę pozycję, jeśli serwer SMTP wymaga szyfrowania SSL (np. G-mail). Ustawienie 

to jest dostępne tylko w wersji profesjonalnej.  

5 Web Server Setting – Skonfiguruj numer portu serwera sieciowego dla wersji sieciowej Voltsoft. 

Lokalny adres IP również będzie wyświetlony jednak przy więcej niż jedna karcie pamieci wyświetli się 

tylko pierwszy wykryty adres IP.  

6 Maximum login number - Steruje maksymalną liczbą równoczesnych loginów.  

Restart Voltsoft Server – Restartuj serwer Voltsoft. 

Save - Zapisz i wyjdź z modułu.  

Close - Zamknij moduł bez zapisywania.  
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5.3 Dodawanie nowego urządzenia 

Ten moduł wyświetli się automatycznie po podłączeniu nowego urządzenia do komputera.  

 

Aby otworzyć ten moduł ręcznie, kliknij Device Management->Add New Device. 

 

1 Wybierz Device aby dodać nowe urządzenie.  

1. Wybierz serię urządzenia ( w aktualnej wersji dostępny tylko Bufor Danych).  

2. Wybierz numer modelu.  

3. Wpisz unikalny alias.  

2 Auto-detect – Kliknij ten przycisk, aby system sam wykrył podłączone, ale nie zarejestrowane 

urządzenia.  

3 Add - Kliknij przycisk Add, aby potwierdzić dodanie urządzenia.  

4 Close - Kliknij przycisk Close - zamknij ten moduł. 
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5.3.1 Dodawanie EL4000 

EL4000 nie łączy się fizycznie z komputerem. Wgrane zostaną dane z karty pamięci i urządzenie 

trzeba będzie dodać ręcznie. Aby dodać EL4000 do systemu, kliknij Device Management->Add New 

Device. 

 

Wybierz “Data Logger” w pozycji Device Series oraz “EL4000” w pozycji Model Number, wpisz alias i 

kliknij “Add”, aby kontynuować.  

Po udanej operacji nowe urządzenie zostanie dodane do listy urządzeń:  

 

Ponieważ EL4000 nie łączy się fizycznie z komputerem , nie pozostaje w statusie online / offline, i 

jego ikona zawsze będzie niebieska.  
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5.4 Usuwanie istniejącego urządzenia  

Ten moduł pozwala użytkownikowi na usunięcie urządzeń, które nie są używane. Aby otworzyć ten 

moduł, kliknij Device Management->Remove Existing Device. 

 

Aby usunąć urządzenie, zaznacz urządzenie na liście i kliknij przycisk Remove. 

Kliknij przycisk Remove All, aby usunąć jednocześnie wszystkie urządzenia.  
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5.5 Urządzenie – panel sterowania  

Otwarte urządzenie będzie wyświetlone w obszarze panelu sterowanai urządzenia w postaci zakładki. 

Każda zakładka zawiera informacje o pojedynczym urządzeniu.  

 

Każda zakładka urządzenia zawiera: 

1 Obszar Device Menu – każde urządzenie posiada włane menu, które zostanie objaśnione w kolejnej 

sekcji.  

2 Zakładka Data – wyświetla wybrane dane w postaci listy.  

3 Zakładka Graph - wyświetla wybrane dane w postaci graficznej.  
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5.5.1. Urządzenie – obszar menu  

Każda zakładka urządzenia zawiera własne menu, zawierające:  

1 Device -> Settings - Uruchamia stronę ustawień dla urządzenia. Układ będzie różny dla różnych 

typów urządzeń.  

2 Device -> Stop - Zatrzymuje wgrywanie danych w czasie rzeczywistym (dostępne tylko dla 

urządzenia czasu rzeczywistego).  

3 Device -> Download Data - - Wgrywanie danych z urządzenia.  

4 Device -> Display / Plot Data – Wybór zakresu czasowy dla urządzenia, w którym zostanie 

wznowiony odczyt urządzenia.  

5 Device -> Email Alert - Uruchamia moduł e-maila alarmowego. (Dostępne tylko dla urządzenia 

czasu rzeczywistego w wersji profesjonalnej).  

6 Graph -> Plot Colour – Otwiera moduł Plot Colour pozwalający na zmianę koloru poszczególnych 

linii.  

7 Graph -> Background Colour - Zmiana koloru tła wykresu na biały lub czarny.  

8 Graph -> Grid – Steruje ukryciem/pokazaniem siatki na wykresie.  

9 Graph -> Line - Steruje ukryciem/pokazaniem linii na wykresie.  

10 Graph -> Print - Drukuje wygenerowany wykres.  

11 Graph -> Save Image As - Zapisuje obraz w wybranym formacie.  

12 Graph -> Zoom Out - Przybliża jeden poziom.  

13 Graph -> Zoom To Fit - Resetuje funkcje przybliżania i zmniejszania.  

14 Graph -> View All Data - Zmniejsza wykres aby wszystkie dane były widoczne(dostępne tylko dla 

urządzenia czasu rzeczywistego). 
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1. Ustawienia urządzenia 

Różne modele urządzenia mają różne parametry w zakresie ustawień a zatem ich strony ustawień 

będą się różnić. Różne strony ustawień dla urządzeń przedstawiono w dalszej części instrukcji.  

2. Stop 

Kiedy urządzenie pracuje w trybie czasu rzeczywistego, użytkownik może zatrzymać wgrywanie za 

pomocą tej funkcji.  
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3.Wgrywanie danych 

Ten moduł pozwala użytkownikowi wgrać dane z urządzenia.  

Ogólny interfejs dla wgrywania danych.  

 

Kliknij przycisk “OK”, aby rozpocząć wgrywanie.  

Interfejs dla wgrywania danych urządzenia VC930 / VC950 . 

 

Urządzenia VC930 i VC950 posiadają dwa rodzaje wgrywania danych, DataLog oraz Storage, wybierz 

jeden z nich, aby rozpocząć wgrywanie i kliknij “OK”, aby kontynuować.  

Interfejs dla wgrywania danych urządzenia EL4000. 

 

Aby wgrać dane, kliknij “…”, wybierz lokalizację pliku danych i kliknij przycisk “Download”, aby 

rozpocząć wgrywanie.  
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4. Dane wyświetlacza/wykresu (seria bufora danych) 

Ten moduł pozwala użytkownikowi wybrać zakres odczytów urządzenia i wyświetlić je w postaci 

zakładki danych i zakładki wykresu.  

 

1 PC Storage Range – Wgrywa wszystkie dane zapisane w bazie danych.  

2 Time Range - Wybierz zakres odczytu danych.  

3 Real Time Data – Ta opcja dostępna jest tylko dla niektórych urządzeń (patrz Załącznik). Po 

zaznaczeniu tej opcji, system wgra dane czasu rzeczywistego z urządzenia, a nie dane zapisane.  

4 OK - Kliknij OK aby zatwierdzić wprowadzone dane i wyświetlić wybrane odczyty w zakładkach 

danych i wykresu.  

5. Cancel - Zamknij ten moduł. 

Czas wgrywania wydłuży się przy odzyskiwaniu większej ilości danych, a zatem system będzie 

ograniczony do zwrotu pierwszych 100 000 rekordów, które spełniają twoje wybrane kryteria (dla 

wersji sieciowej zwróconych będzie tylko pierwsze 10000 rekordów).  
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5. . Dane wyświetlacza/wykresu (seria DMM – VC930 / VC950) 

 

Interfejs jest podobny do serii bufora danych za wyjątkiem braku opcji czasu rzeczywistego, 

użytkownik musi wybrać kolumnę danych, która będzie wyświetlana.  

6. Dane wyświetlacza/wykresu (seria DMM– VC880 / VC650BT) 

 

Interfejs jest podobny do serii bufora danych za wyjątkiem braku opcji czasu rzeczywistego; 

użytkownik musi wybrać kolumnę danych, która będzie wyświetlana.  
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7.Kolor wykresu  

 

Ten moduł pozwala użytkownikowi wybrać kolor linii wykresu, kliknięcie na nazwę koloru uruchamia 

paletę kolorów. Kliknij na dany kolor a następnei kliknij OK., aby go wybrać. 
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5.5.2. Zakładka Dane (seria bufora danych)  

 

1 PC Storage Range – Zakres danych zapisanych w bazie danych.  

2 Reading Summary Click – Kliknij na symbol obok tytułu podsumowania, aby ukryć/wyświetlić 

obszar podsumowania. Obszar podsumowania wyświetla maks/min/średnią wartość pomiaru.  

3 Data Reading – Dane zostaną wyświetlone w postaci tabeli.  

4 Export CSV - Kliknij na ten przycisk, aby eksportować dane do formatu CSV. 

5 Export Excel - Kliknij na ten przycisk, aby eksportować dane do formatu Excel. 
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5.5.3. Zakładka Dane (seria DMM– VC930 / VC950) 

 

Interfejs produktów serii DMM jest podobny do serii bufora danych; posiada jednak więcej funkcji:  

1 Przycisk Record / Display - Za pomocą tych przycisków można przełączyć pomiędzy trybem 

wyświetlacza a trybem zapisu. W trybie wyświetlacza odczyt zmierzony przez urządzenie zostanie 

wyświetlony w obszarze wyświetlacza.W trybie zapisu zmierzony odczyt nie tylko zostanie 

wyświetlony, ale także zostanie zapisany do bazy danych.  

Uwaga: 

i) Jeśli urządzenie pozostaje w trybie zapisu oznacza to, że jednocześnie pozostaje w trybie 

wyświetlacza.  

ii) Zatrzymanie trybu wyświetlacza również zatrzyma tryb zapisu.  

2 Obszar Display– Wyświetla zmierzoną wartość.  

3 Back to real time mode Ten przycisk pokaże, kiedy urządzenie pozostaje w trybie czasu 

rzeczywistego, ale interfejs nie pokazuje danych czasu rzeczywistego (np. wgrywanie danych 

bufora/danych historycznych). Klikając na ten przycisk możesz przywrócić wyświetlanie danych czasu 

rzeczywistego na interfejsie.  
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5.5.4. Zakładka Dane (seria DMM– VC880 / VC650BT) 

 

Interfejs produktów serii DMM jest podobny do serii bufora danych; posiada jednak więcej funkcji:  

1 Przycisk Record / Display - Za pomocą tych przycisków można przełączyć pomiędzy trybem 

wyświetlacza a trybem zapisu. W trybie wyświetlacza odczyt zmierzony przez urządzenie zostanie 

wyświetlony w obszarze wyświetlacza.W trybie zapisu zmierzony odczyt nie tylko zostanie 

wyświetlony, ale także zostanie zapisany do bazy danych.  

Uwaga: 

i) Jeśli urządzenie pozostaje w trybie zapisu oznacza to, że jednocześnie pozostaje w trybie 

wyświetlacza.  

ii) Zatrzymanie trybu wyświetlacza również zatrzyma tryb zapisu.  

2 Przycisk Command – patrz sekcja poniżej.  

3 Obszar Display– Wyświetla zmierzoną wartość.  

4 Back to real time mode Ten przycisk pokaże kiedy urządzenie pozostaje w trybie czasu 

rzeczywistego, ale interfejs nie pokazuje danych czasu rzeczywistego (np. wgrywanie danych 

bufora/danych historycznych). Klikając na ten przycisk możesz przywrócić wyświetlanie danych czasu 

rzeczywistego na interfejsie.  

Przycisk Command  

Manual Range Kliknij, aby wysłać polecenia, aby urządzenie weszło w zakres ręczny. 

Auto Range Kliknij, aby wysłać polecenia, aby urządzenie weszło w zakres automatyczny.  

MAX / MIN / AVG Kliknij, aby wysłać polecenia w celu uruchomienia funkcji maksymalna, minimalna, 

średnia.   

Exit Max Kliknij, aby wysłać polecenia do opuszczenia funkcji maksymalna, minimalna, średnia.   
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NG Beep W trybie COMP VALUE, jeśli nie zadziałał, kliknij przycisk aby wyłączyć/włączyć alarm.  

Light Kliknij, aby wysłać polecenia uruchomienia funkcji podświetlenia urządzenia, a następnie kliknij 

funkcje wyjścia.  

Select Kliknij, aby wysłać polecenia uruchomienia wybranej funkcji urządzenia.  

Hold Kliknij, aby wysłać polecenia zachowania funkcji przez urządzenie a następnie kliknij aby wyjść z 

utrzymania funkcji.  

REL Kliknij, aby wysłać polecenia uruchomienia funkcji wartości względnej, a następnie kliknij aby 

wyjść z tej funkcji. 

Pass Beep W trybie COMP VALUE, jeśli zadziałał, kliknij przycisk aby wyłączyć/włączyć alarm. 

COMP Value Otwórz/opuść tryb wartości COMP. 

COMP Setting Wyskakujące okienko dialogowe porównania danych.. 

Single Log Kliknij, aby wysłać polecenia uruchomienia zapisu pojedynczych danych urządzenia.  

Series Log Kliknij, aby wysłać polecenia uruchomienia ciągłego zapisu danych urządzenia, następnie 

kliknij aby wyjść z tej funkcji.  

Load Comparison Memory Kliknij, aby wysłać polecenia wysłania danych porównawczych zapisanych 

przez urządzenie.  

Clear Comparison Memory Wyczyść dane porównawcze z urządzenia.  

Load Device Memory Kliknij, aby wysłać poleceniawysłania nieporównanych danych zapisanych przze 

urządzenie.  

Clear Device Memory Wyczyść nieporównane dane z urządzenia. 

Okno dialogowe porównywania danych  

 

Setup Enter： 

Po przyciśnięciu przycisku można modyfikować górny/dolny limit oraz tryb, jeśli przycisk jest w 

pozycji UP, ustawienia zostaną wysłane i zapisane w urządzeniu.  
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5.5.5. Zakładka Wykres 

 

1 Line Graph Ten obszar wyświetla odczyt urządzenia w postaci wykresu.  

Użytkownik może 

- Kliknięciem lewego przycisku myszki wybrać obszar przybliżenia.  

- Kliknięciem Shift + i lewego przycisku myszki oddalić wykres.  

- Kliknięciem prawego przycisku myszki wyświetlić menu zawartości.  

2 Graph Legend Wyświetla definicje odczytu dla różnych linii.  

3 Y-Axis Istnieją dwie osie Y do wyświetlania różnych odczytów.  

4 Individual Reading Najedź myszką na linię wykresu, aby zobaczyć wartość odczytu wraz z czasem 

zapisu.  
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5.6 Ustawienia urządzenia 

Różne modele urządzenia posiadają różne parametry ustawień a zatem ich strony ustawień będą 

różne.  

5.6.1 Ustawienia DL101T  

 

1 Time Konfiguruj wartość danych godziny urządzenia. Użytkownik może określić dany czas lub użyć 

czasu z systemu.  

2 Logger Name Wpisz unikalny alias dla tego urządzenia. 

3 Record Start Condition By Button – Bufor danych rozpocznie zapis dopiero po dwukrotnym 

przyciśnięciu czerwonego przycisku na urządzeniu przez użytkownika.  

Po ustawieniu – bufor danych rozpocznie zapis natychmiast po ustawieniu.  

4 Sample Points – Ustaw bufor danych na zapis ze skończoną liczbą odczytów.  

5 Sample Rate - Ustaw bufor danych na zapis odczytów z określoną częstotliwością. 

6 Recording Time - Oblicza czas zapisu w oparciu o wybrane punkty próbkowania i częstotliwość 

próbkowania.  

7 LED Flash Cycle - Konfiguruje cykl migania diody LED – im dłuższy czas tym większa żywotność 

baterii.  

8 Enable LED Alert Aktywuj/dezaktywuj miganie diody LED po wyzwoleniu alarmu.  

9 Temperature Low / HighAlarm - Konfiguruj poziom alarmu niskiej/wysokiej temperatury.  

10 Przycisk Default - Wgraj domyślne ustawienia fabryczne.  

11 Przycisk Setup - Zapisz zmiany. 

12 Przycisk Close - Zamknij ten interfejs. 
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Uwaga: po zakończeniu ustawienia wszystkie zapisane dane zostaną trwale usunięte.  
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5.6.2 Ustawienia DL121TH  

 

Strona ustawień DL121TH jest podbna do strony ustawień DL101T ale dodatkowo posiada opcję 

ustawiania wartości alarmu niskiej/wysokiej wilgotności.  
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5.6.3 Ustawienia DL141TH  

 

1 Device Time Konfiguruj wartość danych godziny urządzenia. Użytkownik może określić dany czas 

lub użyć czasu z systemu. 

2 Logger Name Wpisz unikalny alias dla tego urządzenia. 

3 Record Start Condition By Button – Bufor danych rozpocznie zapis dopiero po dwukrotnym 

przyciśnięciu czerwonego przycisku na urządzeniu przez użytkownika.  

Po ustawieniu – bufor danych rozpocznie zapis natychmiast po ustawieniu.  

4 Sample Rate - Ustaw bufor danych na zapis odczytów z określoną częstotliwością. 

Użytkownik może wprowadzić określone dane w polu edycji z lewej strony i wybrać jednostkę czasu 

korzystając z pola po prawej stronie.  

5 Recording Time - Oblicza czas zapisu w oparciu o wybrane punkty próbkowania i częstotliwość 

próbkowania. 

6 LED Flash Cycle - Konfiguruje cykl migania diody LED – im dłuższy czas tym większa żywotność 

baterii. 

7 Recording - Ustaw bufor danych na ciągły zapis danych, zapis na wcześniejszych danych (Circulating 

Record), lub zatrzymanie zapisu (No Circulating) po zapełnieniu pamieci bufora danych.  

8 Enable LED Alert Aktywuj/dezaktywuj miganie diody LED po wyzwoleniu alarmu. 

9 Temperature Low / HighAlarm - Konfiguruj poziom alarmu niskiej/wysokiej temperatury.  

10 Humidity Low / High Alarm - Konfiguruj poziom alarmu niskiej/wysokiej wilgotności. 

11 Przycisk Default - Wgraj domyślne ustawienia fabryczne. 
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12 Przycisk Setup - Zapisz zmiany. 

13 Przycisk Close - Zamknij ten interfejs.  
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5.6.4 Ustawienia DL181THP  

 

1 Logger Name Wpisz unikalny alias dla tego urządzenia. 

2 Device Time Konfiguruj wartość danych godziny urządzenia. Użytkownik może określić dany czas 

lub użyć czasu z systemu. 

3 Record Start Condition By Button – Bufor danych rozpocznie zapis dopiero po dwukrotnym 

przyciśnięciu czerwonego przycisku na urządzeniu przez użytkownika.  

Po ustawieniu – bufor danych rozpocznie zapis natychmiast po ustawieniu.  

4 Sample Rate - Ustaw bufor danych na zapis odczytów z określoną częstotliwością. 

5 Sample Points - Konfiguruj punkty próbkowania bufora danych. 

6 Recording Time - Oblicza czas zapisu w oparciu o wybrane punkty próbkowania i częstotliwość 

próbkowania.  

7 Altitude Pozwala użytkownikowi na ustawienia aktualnej wysokości n.p.m.  

8 Record LED Flash Konfiguruje cykl migania diody LED – im dłuższy czas tym większa żywotność 

baterii.  

9 Enable LED Alert Aktywuj/dezaktywuj miganie diody LED po wyzwoleniu alarmu. 

10 Temperature Low / HighAlarm - Konfiguruj poziom alarmu niskiej/wysokiej temperatury.  

11 Humidity Low / High Alarm - Konfiguruj poziom alarmu niskiej/wysokiej wilgotności. 

12 Air Pressure Low / HighAlarm Konfiguruj poziom alarmu niskiego/wysokiego powietrza. 

13 Przycisk Default - Wgraj domyślne ustawienia fabryczne. 
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14 Przycisk Setup - Zapisz zmiany. 

15 Przycisk Close - Zamknij ten interfejs. 
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5.6.5 Ustawienia DL161S  

 

1 Logger Name Wpisz unikalny alias dla tego urządzenia. 

2 Current Time Konfiguruj wartość danych godziny urządzenia. Użytkownik może określić dany czas 

lub użyć czasu z systemu. 

4 Sound Unit Jednostką dźwięku może dBA lub dBC. 

5 Measuring speed Prędkość pomiarowa może być Szybka lub Wolna.  

6 Record Start Condition By Button – Bufor danych rozpocznie zapis dopiero po dwukrotnym 

przyciśnięciu czerwonego przycisku na urządzeniu przez użytkownika.  

Po ustawieniu – bufor danych rozpocznie zapis natychmiast po ustawieniu.  

7 Sample Rate - Ustaw bufor danych na zapis odczytów z określoną częstotliwością. 

8 Sample Points - Konfiguruj punkty próbkowania bufora danych. 

9 Infinite - Tylko w trybie czasu rzeczywistego, wczytywanie będzie trwało do momentu jego 

zatrzymania przez użytkownika.  

10 Recording Time Oblicza czas zapisu w oparciu o wybrane punkty próbkowania i częstotliwość 

próbkowania.  

11 LED Flash Cycle Konfiguruje cykl migania diody LED – im dłuższy czas tym większa żywotność 

baterii.  

12 Logger Mode Manual – Bufor danych rozpocznie zapis po przyciśnięciu przez użytkownika 

czerwonego przycisku na urządzeniu. Instant – Bufor danych rozpocznie zapis natychmiast po 

ustawieniu.  
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13 Storage Setup  Przechowywanie może być w trybie Przechowywania lub Czasu Rzeczywistego. 

Store – Dane będą zapisywane w trybie off-line.  Real Time – Dane będą zapisywane w trybie czasu 

rzeczywistego.  

14 LED Flash for High / Low Alarm Aktywuj/dezaktywuj miganie diody LED po wyzwoleniu alarmu. 

15 Low / High Alarm for dBA Konfiguruj poziom dźwięku (w jednostkach dBA) dla niskiego 

/wysokiego poziomu alarmu. 

16 Low / High Alarm for dBC Konfiguruj poziom dźwięku (w jednostkach dBC) dla niskiego/wysokiego 

poziomu alarmu. 

17 Przycisk Default - Wgraj domyślne ustawienia fabryczne. 

18 Przycisk Setup - Zapisz zmiany. 

19 Przycisk Close - Zamknij ten interfejs. 
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5.6.6 Ustawienia SL451  

 

1 Logger Name - Wpisz unikalny alias dla tego urządzenia. 

2 Sample Rate - Ustaw bufor danych na zapis odczytów z określoną częstotliwością. 

3 Sample Points - Konfiguruj punkty próbkowania bufora danych. 

4 Infinite -Tylko w trybie czasu rzeczywistego, wczytywanie będzie trwało do momentu jego 

zatrzymania przez użytkownika.  

5 Low / High Alarm for dBA Konfiguruj poziom dźwięku (w jednostkach dBA) dla niskiego/wysokiego 

poziomu alarmu. 

6 Low / High Alarm for dBC Konfiguruj poziom dźwięku (w jednostkach dBC) dla niskiego/wysokiego 

poziomu alarmu. 

7 Przycisk Default - Wgraj domyślne ustawienia fabryczne.  

8 Przycisk Setup - Zapisz zmiany. 

9 Przycisk Close - Zamknij ten interfejs. 
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5.6.7 Ustawienia VC 930 / VC 950  

 

1 Logger Name – wpisz unikalny alias dla tego urządzenia.  

2 Sample Points – konfiguruj punkty próbkowania bufora danych.  

3 Infinite – tylko w trybie czasu rzeczywistego, wczytywanie będzie trwało do momentu jego 

zatrzymania przez użytkownika.  

4 Sample Rate – ustaw bufor danych na zapis odczytów z określoną częstotliwością  

5 Alarm Settings* - wybór kolumny pomiaru i poziomu alarmu  

6 Przycisk Setup - zapisz zmiany 

7 Przycisk Close - zamknij ten interfejs  

* Uwaga: Alarm można skonfigurować w następujących zakresach pomiarowych:  

Jednostka funkcja tryb Jednostka funkcja tryb  
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5.6.8 Ustawienia EL4000  

 

1 Time - Konfiguruj wartość danych godziny urządzenia. Użytkownik może określić dany czas lub użyć 

czasu z systemu. 

2 Date Format - Wybierz dd/mm/rrrr lub mm/dd/rrrr 

3 Time Format - Wybierz format 24 / 12 godzinny. 

4 Logger Name - Wpisz unikalny alias dla tego urządzenia. 

5 Logger ID - Wybierz ID bufora z zakresu 0 – 9. 

6 Currency - Wybierz walutę, w celu obliczeń.  

7 Tariff 1 - Cena dla okresu 1 

8 Tariff 2 - Cena dla okresu 2 

9 Default - Przywróć wartość domyślną 

10 Przycisk Setup - Zapisz zmiany i eksportuj plik konfiguracyjny 

11 Przycisk Close - Zamknij ten interfejs. 
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5.6.9 Ustawienia VC 880 / VC 650BT  

 

1 Logger Name - Wpisz unikalny alias dla tego urządzenia. 

2 Sample Points - Konfiguruj punkty próbkowania bufora danych. 

3 Infinite - tylko w trybie czasu rzeczywistego, wczytywanie będzie trwało do momentu jego 

zatrzymania przez użytkownika. 

4 Sample Rate Ustaw bufor danych na zapis odczytów z określoną częstotliwością. 

5 Skip repeat reading System nie zapisze zdublowanych odczytów po wybraniu tej opcji.  

6 Alarm Settings* Wybierz kolumnę pomiaru i poziom alarmu. 

7 Przycisk Setup - Zapisz zmiany. 

8 Przycisk Close - Zamknij ten interfejs. 

* Uwaga: Alarm można skonfigurować w następujących zakresach pomiarowych:  

Funkcja  jednostka  tryb  
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6. Kalibracja urządzenia 

6.1. DL161S 

DL161S oferuje użytkownikowi interfejs służący do kalibracji poziomu dźwięku. Dopuszczalna wartość 

regulacji kalibracji znajduje się w zakresie – od 12.5 dB do 12.5 dB. 

 

Wpisz wartość i kliknij “OK”, aby ją ustawić. 



                                 

Strona 43 z 64 
Dystrybucja Conrad Electronic Sp. z o.o., ul. Królowej Jadwigi 146, 30-212 Kraków, Polska 

Copyright © Conrad Electronic 2012, Kopiowanie, rozpowszechnianie, zmiany bez zgody zabronione. 

www.conrad.pl 

www.conrad.pl 

7. Wersja profesjonalna 

Wersja profesjonalna posiada wszystkie funkcje wersji standardowej oraz kilka funkcji 

zaawansowanych. Poniższe funkcje będą dostępne po aktywacji wersji profesjonalnej on-line.   

7.1.Zarządzanie użytkownikiem 

Aby uruchomić moduł zarządzania użytkownikiem, kliknij  na File->User Management w menu 

głównym. Zarządzanie uzytkownkiem tego modułu oferowane jest wyłącznie w wersji sieciowej.  

 

1 User List Wyświetla listę użytkowników Voltsoft. 

2 User Details Clicking Po kliknięciu na nazwę użytkownika wyświetlą się szczegółowe informacje o 

użytkowniku: użytkownik może: 

Modyfikować hasło 

Przypisać datę ważności dla tego użytkownika 

Zmodyfikować aktywny status dla tego użytkownika  
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3 User Privileges  Kontroluje czy użytkownik może uzyskać dostęp  do modułu zarządzania 

użytkownikiem w wersji sieciowej.  

4 Device List Kontroluje urządzenia dostępne dla wybranego użytkownika w wersji sieciowej. 

Delete Kliknij na użytkownika na liście użytkowników i za pomocą przycisku Delete usuń istniejącego 

użytkownika.  

Add Kliknij na przycisk Add aby utworzyć nowego użytkownika.  

Save Zapisz informacje o aktualnym użytkowniku ave the current user’s information. 

Close Zamknij ten moduł. 
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7.2. Zarządzanie pocztą 

Ten moduł pozwala użytkownikowi na zarządzanie adresami poczty osób otrzymujących maile 

alarmowe. Aby uruchomić moduł, kliknij File->Email Management w menu głównym. 

 

1 Email Address – Adres e-mail konfigurowany jest w Voltsoft. 

2 Add New Email  - Wprowadź nowy adres e-mail i kliknij Add, aby dodać nowy e-mail do systemu.  

3 Remove Email  - Kliknij e-mail na liście adresów i kliknij przycisk Remove, aby usunąć e-mail z 

systemu.  

4 Close - Zamknij ten moduł. 
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7.3.Wzór e-maila 

Aby uruchomić moduł, kliknij Preference->Email Template. 

 

1 Language - Wybierz język wzoru e-maila.  

2 Message Content – Wpisz tytuł i wzór dla e-maila, który będzie wysłany w różnych przypadkach:  

Przypadek  1: alarm maksymalny 

Ten e-mail będzie wysłany, kiedy odczyt jest wyższy niż poziom alarmu maksymalnego.  

Przypadek 2: alarm minimalny  

Ten e-mail będzie wysłany, kiedy odczyt jest wyższy niż poziom alarmu  minimalnego.
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przypadek 3: poziom Reset  

Ten e-mail będzie wysłany, kiedy odczyt był najpierw na poziomie alarmu max/min ale powrócił do 

poziomu normalnego.  

3 Save Kliknij przycisk Save, aby zapisać wzór.  

4 Close Kliknij przycisk Close, aby zamknąć moduł.  

Zmienne  

Poniższe pozycje zdefiniowano jako zmienne i zostaną one zastąpione podczas wysyłania poczty.  

1 {DEVICE} alias urządzenia  

2 {COLUMN}  nazwa odczytu urządzenia  

3 {READING} wartość odczytu urządzenia  

4 {TIME} czas wystąpienia zdarzenia  
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7.4. E-mail alarmowy 

 

Voltsoft posiada funkcję e-maila alarmowego, która wysyła e-mail do określonego użytkownika, kiedy 

odczyt urządzenia znajduje się poniżej lub powyżej określonego poziomu. 

Użytkownik może za pomocą tego modułu wybrać odbiorcę e-maila dotyczącego określonego 

urządzenia.  
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7.5. Wykres użytkownika  

Wykres użytkownika pozwala na umieszczenie na wykresie odczytów z większej liczby urządzeń.  

Aby utworzyć wykres użytkownika:  

1. Wybierz Device Management->Custom Graph w menu głównym. 

 

2. Wybierz New, aby utworzyć nowy wykres lub wybierz poprzednio zapisany wykres. Kliknij OK., aby 

kontynuować.  

3. Wyświetli się interfejs informacji szczegółowych wykresu.  

 

4. Następnie użytkownik musi:  

I. Wybrać okres danych lub dane w czasie rzeczywistym (tylko określone urządzenia oferują odczyt w 

czasie rzeczywistym). 

II. Wybrać kolumnę urządzenia i pomiaru.  

III. Kliknij Next Step>, aby kontynuować. 
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IV. Dla każdej kolumny system wyświetli maksymalną i minimalną wartość danych dla wybranego 

okresu.  

V. Dla każdej kolumny użytkownik może określić czy jest rysowana w Y1 czy Y2, określić wartości 

maksymalne i minimalne osi Y, odpowiedni kolor linii lub wyosiować poziom zero na ten sam poziom 

lub nie.  

VI. Kliknij Finisz, aby wygenerować wykres.  
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7.6. Interfejs sieciowy  

7.6.1 Używanie systemu zarządzania urządzeniem (sieć) 

Voltsoft posiada także interfejs sieciowy dzięki któremu użytkownik może sterować urządzeniem 

przez  Internet Explorer (wersja 7 lub 8). 

Aby otworzyć interfejs sieciowy Voltsoft, otwórz Internet Explorer (I.E.) na komputerze i wpisz 

http://127.0.0.1 or http://localhost. Jeśli zmienisz numer portu w ustawieniach ogólnych na inny 

numer portu, musisz wprowadzić także numer portu na przykład http://127.0.0.1:8080. 

Po udanej operacji wyświetli się strona logowania.  

 

Wprowadź ważny login użytkownika utworzony w module zarządzania użytkownikiem.  
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Po zalogowaniu wyświetli się ekran główny podobny do ekranu klienta Windows. 

 

Kliknij na pozycję urządzenia. Wyświetli się komunikat o konieczności instalacji sterownika ActiveX 

wydanego przez CEI, Conrad Electronic International (HK) Ltd. Kliknij Install, aby go zainstalować.  

 

Po instalacji ekran powinien wyglądać następująco:  
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7.6.2 Dostęp do sieci Voltsoft z komputera zdalnego  

Sieć Voltsoft pozwala użytkownikowi na sterowanie informacjami o urządzeniu z komputera zdalnego 

poprzez I.E., podobnie jak w przypadu funkcji zdalnych aparatu IP. Komputer może wymagać 

pewnych zmian konfiguracyjnych w celu umożliwienia dostępu nadchodzącego przesyłu. 

1. Najpierw sprawdź adres IP komputera otwierając stronę ustawień w kliencie Windows  lub 

sprawdzając poprzez okienko poleceń.  

Otwórz okienko poleceń i wpisz ‘ipconfig’. 

 

Na przykład twój adres IP to 192.168.1.130 zgodnie z powyższym przykładem.  

2. Następnie sprawdź ustawienia zapory. Wejdź do panelu sterowania i kliknij na Zapora Windows. 
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3. W celu sprawdzenia możesz wylączyć zaporę, możesz też skonfigurować zaporę tak, by pozwalała 

na wyjątki. W szczegółowych sprawach kontaktuj się z administratorem sieci.  

4. Następnie spróbuj uzyskać dostęp do sieci Voltsoft z innego komputera w tej samej sieci. Np. w 

powyższym przypadku powinieneś wpisać http://192.168.1.130 w I.E. W razie problemów kontaktuj 

się z administratorem sieci w celu sprawdzenia połączenia pomiędzy komputerami.  

5. Możesz uzyskać dostęp do sieci Voltsoft przez Internet ze zdalnego miejsca w biurze będziesz 

jednak musiał podać ustawienia sieci komputera administratorowi sieci w celu skonfigurowania 

rutera oraz zapory.  
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7.6.3 Użycie systemu (sieci) Voltsoft  

Interfejs klienta siciowego będzie bardzi podobny do klienta Windows. 

i. Login 
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ii. Ekran główny 

Bufor danych 
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DMM 

 

Układ dla urządzenia DMM w wersji sieciowej może różnić się nieco od wersji Windows. Np. status 

przycisku “Record” i “Display” nie będzie odświeżał się automatycznie. Dodano zatem przycisk 

“Refresh”, którego kliknięcie odświeża status przycisków.  

Układ ekranu 

Jedną z najważniejszych różnić pomiędzy wersją Windows a sieciową jest fakt, że w urządzeniu z 

wersją sieciową można ustawić trzy różne układy okna: 1) jedna kolumna, 2) dwie kolumny, 3) układ 

zakładki.  
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1) Pojedyncza kolumna 
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2) Dwie kolumny 

 



                                 

Strona 61 z 64 
Dystrybucja Conrad Electronic Sp. z o.o., ul. Królowej Jadwigi 146, 30-212 Kraków, Polska 

Copyright © Conrad Electronic 2012, Kopiowanie, rozpowszechnianie, zmiany bez zgody zabronione. 

www.conrad.pl 

www.conrad.pl 

3) Układ zakładek 
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7.6.4 Ograniczenia wersji sieciowej  

Chociaż interfejs i funkcje wersji sieciowej są bardzo zbliżone do wersji Windows istnieje jednak 

między nimi kilka różnic.  

1) Wersja sieciowa przeznaczona jest dla użytkowników którzy nie znajdują się przy kompouterze 

podłączonym do urządzenie, tym samym w wersji sieciowej nie występuje funkcja dodawania i 

usuwania urządzenia - “Add and Remove Device”. 

2) Wersja sieciowa nie posiada odświeżania niektórych obszarów ( w porównaniu z wersją Windows), 

użytkownik musi przycisnąć przycisk “F5” lub “Refresh” w pasku narzędzi przeglądarki na interfejsie. 

Obszary te to:  

i. lista urządzeń  

ii. status czas rzeczywistey/wyświetlacz dla VC930 lub VC9050 
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8. Automatyczna aktualizacja  

Voltsoft przeprowadzi sprawdzenie wersji przy każdym uruchomieniu, jeśli dostępna jest nowa 

wersja, wyświetli się następujące okno dialogowe: 

 

Użytkownik może kliknąć “Yes”, abyprzeprowadzić aktualizację, lub  “No” aby ją pominąć. Aby 

korzystać z nowych funkcji Voltsoft, zdecydowanie zaleca się wykonywanie aktualizacji.  

 

System będzie uruchamiał się dalej po dokonaniu aktualizacji.  
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9. Załącznik  

9.1. Spis urządzeń z funkcją czasu rzeczywistego  

Tyko poniższe urządzenia posiadają funkcje czasu rzeczywistego:  

Rodzina         numer modelu 

Bufor danych       DL161S 

SL400 

DMM         VC 930 / VC950 

Uwagi: prędkość zapisu danych (tj. częstotliwość próbkowania) w dużej mierze zależy od pojemności 

komputera i jego wydajności. Ograniczją ją dwa, podłączone urządzenia czasu rzeczywistego 

pracujące równocześnie.  
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